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INTRODUCTION

Australian Tropical Rain Forest Trees: An Interactive Identification System
was published in 1993, and covered 1056 tree species in 84 families in
northern Australia. Although that book was a significant milestone, we
believed that our task would not be complete until we had constructed
similar databases and computer-based keys for the other life forms in
Australian tropical rain forests. We also wanted to improve the
identification system to make it even easier to identify rain forest plants
and gain substantial information about them.

Australian Tropical Rain Forest Trees and Shrubs was published in 1999,
completing Step 2 in the process of producing an information system
for tropical Australian rain forest plants.

The latest version, Australian Tropical Rain Forest Plants: Trees, Shrubs
and Vines, completes Step 3 in our plan to produce an information
system for Australian tropical rain forest plants. It includes 455 of the
estimated 500 species of vines thought to occur in these forests. They
are an interesting group of plants but sometimes difficult to collect and
study. The larger vines are thought to comprise a significant part of the
overall dynamics of rain forest but their contribution is not always
obvious.

Significant advances continue to be made in computer technology. The
hardware operates at greater speeds, the software is increasingly
sophisticated, the storage capacity of hard disks increases at an
exponential rate and other data storage facilities such as CDs and DVDs
are increasingly commonplace. The capacity to store and retrieve data
has now completely outstripped our capacity to accumulate it by careful
observation and dissection of specimens with our current resources. Our
efforts to make taxonomic information on northern Australian rain
forests available to the wider scientific community and the population
as a whole is no longer restrained by machine capacity. We live in
exciting times and although we try to keep abreast of recent
developments we find it difficult to avoid the conclusion that we, and
the rest of the taxonomic community, are not really utilising the
available technology to our best advantage.
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Collection, preservation, careful dissection and observation of specimens
are of great importance now, just as they were in the past. The use of
voucher specimens preserved in a herbarium where all specimens are
databased is vital to a large and complex project such as this one. This
project will never supplant the work of the individual taxonomist
revising particular groups. We need taxonomic revisions to define
species limits, to elucidate species relationships and to sort out and
present the nomenclature in a logical and clearcut way so that the
literature pertaining to a particular species can be accessed.

The number of images included in this version is significantly greater
than in the 1999 version, and includes images of seedlings. It is
probably not generally appreciated just how difficult it is to produce
seedlings of all the species encountered and, having done all this work,
we feel it is necessary to make them available digitally for the benefit of
all users. Most images included in the key were gathered by CSIRO
staff as part of this research project; however, we are indebted to the
following people who allowed us to use images from their private
collections: Stan Breeden, Bill Cooper, Andrew Ford, Penny Goulter,
Mick Godwin, Bruce Gray, Barry Jago, Andrew Small, Geoff Stocker
and Heather Windsor.

Although the information in the CSIRO Atherton herbarium was
generally sufficient to document the distribution of trees, shrubs and
vines in Queensland and Western Australia, it was incomplete for the
Northern Territory. We are therefore grateful to Greg Leach and Clyde
Dunlop for providing database information on rain forest plants from
the Northern Territory herbarium. In addition, our information on the
distribution of Queensland plants was augmented by information from
the Queensland Herbarium.

We have attempted in this version to cover most of the commonly
encountered synonyms associated with the species included. 
The Australian Plant Name Index
(http://www.cpbr.gov.au/cpbr/databases/apni.html) was a major source
of nomenclatural information for this open-ended task which can never
be regarded as complete. However, we hope that it will assist some users
to link previous names with currently accepted names.
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Once again, we are indebted to a large number of people for help and
encouragement. We have received help from the staff of various state
herbaria in Western Australia, Northern Territory, Queensland, New
South Wales, Victoria and the Australian National Herbarium in
Canberra. Our home institutions have provided the basic staffing
framework for work on the key; however, this has been augmented in
these stringent economic times by timely injections of additional funds
from the Co-operative Research Centre for Tropical Rainforest Ecology
and Management. This allowed us to employ Andrew Ford and Justin
Seawright both of whom made significant contributions to this version.
Without the help from this agency, this work could not have been
accomplished in the timeframe. The following are thanked for the time
and effort they put in to reviewing draft versions of the key, and for
their valued suggestions: Jeremy Bruhl, Dale Dixon, Betsy Jackes, Laurie
Jessup and Kevin Kenneally.

Finally, our colleagues in the Tropical Forest Research Centre at
Atherton have also assisted in numerous ways and have tolerated our
strange behaviour during our more stressful periods.

Despite careful dissection and recording of thousands of observations,
we know there are gaps in our database and presumably errors in
recorded observations. We therefore ask anyone who experiences
problems to bring them to our attention and submit voucher
specimens, so that we can check the appropriate morphological features.
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GETTING STARTED

Installation options
The program and images come on two CDs:

● CD 1 (green in colour, labelled Setup) contains the installation
procedure, the program and data files, and the seedling images.

● CD 2 (red in colour, labelled Images) contains the leaf, photograph
and line drawing images of the adult plant.

Three installation options are provided, allowing the user to customise
the extent to which the images are copied to the hard disk.

1 Program only on hard disk: the program and the data files are
copied to the hard disk, but all the images are run from the CD-
ROM. This uses the minimum amount of hard disk space
(approximately 25 Mb). However, both CDs will be required to
access all the images, and it will be necessary to swap the CDs in
the CD-ROM drive if you wish to move between adult and
seedling images. This option is useful where hard disk space is at a
premium.

2 Program, photo and leaf images on hard disk: the program and the
data files are copied to the hard disk, along with the photograph,
leaf and line drawing images. This uses a larger amount of hard disk
space (approximately 675 Mb) but means that the images listed are
more rapidly accessed. The seedling images must be accessed from
CD 1, but that is the only CD required after installation. This
option is useful where the program will be used predominantly for
identification of adult plants, and the seedling images will only be
accessed at infrequent intervals.

3 Program and all images on hard disk: the program, data files and
all images are copied to the hard disk. This uses the largest amount
of hard disk space (approximately 1 Gb), but means that all images
are rapidly accessible. This option is useful where hard disk space is
no problem, and where rapid access to the images is required.
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Note: If you leave some or all of the images on the CD-ROM drive, then change
the configuration of the computer such that the drive letter of the CD-ROM
drive is changed, you may need to re-install the program so that the program
correctly accesses the files on the CD-ROM.

How to install the program
An installation program (setup.exe) is provided to correctly install the
program and any associated files, and to place the program in the Start
menu.

1 Place CD 1 (green in colour, labelled Setup) in the CD-ROM
drive.

2 To start the setup program either:

● select Start, Run, then type d:\setup.exe (where d represents 
your CD-ROM drive letter), or

● browse to the CD-ROM drive and double-click on setup.exe.

3 The installation program will lead you through the steps necessary
to install the program.

4 Follow the prompts to select the desired installation option (see
above for details), which will then copy the selected files to the hard
disk and set up the program in the Start menu, ready to run.

Screen display
The program is easiest to use when run on a computer and monitor set
at SVGA resolution (800 x 600) or higher. Working with a number of
different character sets and a number of possible taxa, and therefore a
number of different windows, proves much easier when the monitor is
set to higher resolutions.

The monitor should be set to a minimum of 256 colours. The program
will display images quite adequately in this mode, although the images
will be slightly improved by displaying at higher colours (millions of
colours). If a trade-off is required between screen resolution and
number of colours, then, provided that the minimum of 256 colours is
used, the higher screen resolutions are preferable.
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The rain forest key status bar, or some other part of the key, may be
hidden by the Windows taskbar. In this case, you should temporarily or
permanently change the properties of the taskbar.

1 Right-click on the taskbar, and select ‘Properties’.

2 Click on the tab ‘Taskbar options’ (if necessary, depending on the
version of Windows) and then unselect ‘Always on top’.

3 Click ‘Apply’ and then ‘OK’ to close. A similar situation may apply
to other taskbars, such as the Microsoft Office taskbar.

All windows in the key are moveable and re-sizeable in the usual way,
however, there are four windows in which the general aspect
(length:width ratio) is important. These are the distribution map, the
leaf image (screen size), the photographs and the seedling image (screen
size) windows. These may only be re-sized using the top, bottom or
corner borders. The width of the window is automatically set to
maintain the correct proportions to the window.

Points to consider when using the key
The key is designed to assist in the identification of rain forest trees,
shrubs and vines in northern Australia, an area covering rain forests
from Townsville to Torres Strait and westward as far as the Kimberley
Region of Western Australia. It is not designed to identify plants outside
this area. As far as this key is concerned, rain forest encompasses a wide
variety of closed forest types in the higher rainfall areas of northern
Australia. It does not include open eucalypt forests or mangrove forests,
although it does include the closed forests found on sand dunes near the
sea. The following commonly used terms are encompassed in our broad
rain forest category: Monsoon Forest, Softwood Scrub, Vine Thicket,
Gallery Forest, Scrub, Jungle and Vine Forest.

Features can be combined in any order to effect an identification, and
leaf, flower, fruit, seedling, family and geographical features can be used
together; bark features are available for trees and large vines, but not for
shrubs and slender vines. Whatever features are being used, it is
important to record only those features about which you are certain. If
you are doubtful about a feature, it should not be used – if in doubt,
leave it out.
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As a seed may not have come from the plant near where it is found, it is
not advisable to use the seedling characters in combination with other
characters, except geographic distribution. Flower and fruit characters
are generally more reliable for identification than leaf characters, which
in turn are more reliable than bark characters. However, availability of
characters may be more important than reliability.

Efforts should be made to reduce the number of possible species to
fewer than 15, otherwise identification by checking the species
descriptions or leaf and other images can become tedious. In most cases,
the number of species can be reduced by adding more features.
Conversely, if there are only a few possible species remaining, there is
little point in adding more features of doubtful applicability to reduce
the number of possibilities to one. Even when there is apparently only
one possibility remaining, the descriptions and images should be
checked for confirmation of the identification. It is always possible that
a mistake has been made, and comparing the specimen with the
additional information and the various images provided may indicate
this.

Future developments and help
Information on future developments with the key, as well as hints or
discussion of any problems, will be placed on the rain forest key
webpage available at:

http://www.cpbr.gov.au/cpbr/cd-keys/rfk/index.html

The webpage will also provide links to other information about research
on Australian tropical rain forest plants.
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USING THE PROGRAM

This is a short introduction to using the program for identification. The
more important features are explained, with a longer review of all the
main features of the program given in the next section. Further
information is available in the on-screen help system within the
program.

After the opening sequence, during which the data are loaded, the main
window will appear. This window has a title bar and a menu bar at the
top, and a status bar at the bottom. Between these is the main
workspace, within which the various windows may be viewed. The
menu bar at the top is used to access the main functions of the
program, while the status bar at the bottom shows the current operation
on the left of the screen, and the number of taxa remaining on the
right.

The first time that the program is used, an initial help screen is
displayed. This provides a brief description of the use of the key. This
help screen may be closed temporarily or permanently. However, it may
be recalled at any time from the Help menu of the main window.

To start an identification, open one or more of the character windows
that correspond to the specimen characters available. Select these from
the character menu. Each character set (habit, bark, leaf, flower, fruit,
seedling, family, geographic area) will open up a window within which
the features from that character set are displayed. These character
windows may be moved and re-sized as desired, to create a comfortable
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on-screen appearance. Additional character windows may be opened at
any time, and the open windows may be closed if required. If any of
these windows are subsequently re-opened during an identification, the
window will appear in the same form as when it was closed.

Within a character window, the features are displayed as a list. The
features are blocked alternately on a white or grey background.
Generally the features within a block correspond to states of a single
character. It is possible to move through the list of characters by using
either the scroll bar to the right of the character window, or the
category menu. In the latter case, the menu shows the various categories
of characters available, and will move directly to the start of any
category selected.
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Character selection is made by left-clicking with the mouse on the text
of a feature, to the right of the red vertical line. Information (help) on
each feature may be obtained by left-clicking on the feature number, to
the left of the red vertical line; in this position the help cursor (question
mark) will appear. As each feature is selected it is highlighted, and the
number of taxa remaining is updated on the status bar. The features
selected for any character set will remain until a new specimen
identification is started (via the File menu on the main menu bar) even
if the window is closed.

The features selected across a number of different character sets may be
viewed in the Features Used window, available under the Characters
menu on the main menu bar. At any time, a feature that has been
selected (and therefore highlighted) may be removed (de-selected) by
again left-clicking on the text of the feature in the character window.
Alternatively, a feature may be de-selected by left-clicking on it in the
Features Used window.

Using the program



A complete list of the names of the species remaining may be seen in
the Species window, available under the Species menu on the main
menu bar. This list of species is automatically updated as further
features are selected (or de-selected). At any stage in the identification,
it is possible to obtain further information on each of the remaining
species. Within the Species window, select one of the remaining species
by left-clicking on its name, and thus highlighting it. This will enable
the Show menu within the Species window. Note that if only one
species remains, it must still be highlighted to enable the Show menu.
The Show menu provides (in separate windows) access to information
on additional features of the species, a leaf x-ray image, a distribution
map, and in most cases one or more photographs of the species and one
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or more seedling images. Line drawings are provided for some of the
species, and these can be accessed under the Show window as well. Also
available, under Information, is general information on the family and
genus, while the Features Coded menu opens up a window with a full
list of the features coded for that species. When one or more of these
informational windows is open, selecting a different species name (by
left-clicking on it in the Species window), will automatically update all
the open windows.

Identification proceeds by observing those features clearly visible on the
specimen and selecting them in the appropriate character windows. If
there is any doubt about a particular feature, it should not be used. In
this way, the number of taxa remaining is gradually reduced. When the
number of taxa remaining is small and all the more obvious features
have been selected, it is best to access the additional information on
each of the remaining taxa in order to choose between them.

Help is available in a number of different ways from within the
program.

● Selecting Help from the main menu will open the help screen with
general instructions on the program. Help on all other aspects of
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the program is available from the list of contents in the left hand
window of the help screen.

● Selecting Help from any of the open windows (including the
character windows) will open the help screen with information on
that window; alternatively, the F1 key may be used to obtain
information on the active window.

● Context-sensitive help is available on all the features. Left-clicking
the feature number (to the left of the red vertical line) in a character
window will open up the help screen with information on that
particular feature, including line drawings of the characters where
appropriate.

When not in use, the help screen should be minimised rather than
closing it, as this will allow quicker access.
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MAIN FEATURES AND COMMANDS

The main capabilities of the program are detailed here. More
information on each topic may be found within the help system.

Main window and status bar
This window serves as the main backdrop for all other windows. The
left hand side of the status bar, which is at the bottom of the window,
indicates the current action, while the number of taxa remaining is
displayed on the right-hand side.

The various windows that open in response to a selection in the main
menu are moveable and re-sizeable. You may set up the selection, size
and position of these windows in any way that suits you. You may move
between windows by re-selecting them from the main menu or, more
conveniently, by right-clicking on any part of the window (left-clicking
in a number of the windows performs a specific action). If a window
becomes hidden by other windows, it may be brought to the front by
re-selecting it from the menu. The help window, if open, should be
minimised when not in use.

General help is available on any window by selecting the Help menu in
that window, or by pressing the F1 key while that window has the focus
(has a highlighted title bar). More specific help is available in a number
of windows, as detailed below.

The rain forest key status bar, or some other part of the key, may be
hidden by the Windows taskbar, or by other taskbars such as the
Microsoft Office taskbar. See under ‘Screen display’ (p.8) for
information on how to correct this.

Main menu
The following facilities are available from the main menu:

File
Start New Specimen
This will clear all currently selected characters and start the
identification of a new specimen. However, it will leave open all
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currently selected windows, maintaining their positions. This is useful if
you have set up the windows in a particular way, and wish to maintain
this configuration for a series of specimens.

Note: You can save this configuration between runs from the Save current
positions item under the Window positions item of the Options menu.

Start and Clear
This will start the identification of a new specimen, clear all currently
selected characters, and close all currently open windows.

Quit
This will close all windows, and exit the program.

Characters
This will open the window for the selected character type (habit, bark,
leaf, flower, fruit, seedling, family or geography). Any characters
previously selected for the current specimen will be highlighted in the
character window. As many of the character windows as required may be
open at any one time, and their size and position may be altered at will.

All characters are routinely available, except that the Bark characters are
only available if either Tree or Vine has been selected as the habit for the
current specimen. The set of Bark characters for trees is different from
that for vines; the appropriate set is enabled when either Tree or Vine is
selected under Habit.

Note: The vine bark characters should only be used for the larger vines, with
well-developed bark. The characters do not apply to the slender vines.

Within each window, the features relating to that character type are
listed. Features that correspond to states of a single character are
blocked alternately on a white or grey background. In most cases, only
one feature would be selected from each block.

To select a feature, move the cursor to that feature and left-click on the
text of that feature, to the right of the red vertical line. The feature
selected will be highlighted. If you change your mind at any stage about
any selected feature, move the cursor to that feature and left-click again.
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The feature will be removed (de-selected) and the highlighting will
cease. Every time a feature is selected or de-selected, the Taxa remaining
total on the status bar is updated. You can move in and out of the
various character windows as much as you wish; all data are retained
until either the Start New Specimen or Start and Clear item is selected
from the main File menu.

General help is available on a character type by pressing the F1 key
while in that character window, or by selecting help on that character
set from the Help menu in the character window. More specific help is
available on each block of features by moving the cursor to the feature
number, to the left of the red vertical line and left-clicking; the help
cursor (generally a question mark) appears when the cursor is over the
feature number. More detailed information on the help window is
provided below.

Within a character window, it is possible to move between the features
in a number of ways. The vertical scroll bar to the right of the window
allows movement up and down one line at a time, one page at a time,
or to any position by dragging the thumb. It is also possible to move
through the list of features via the Category menu in the character
window. A drop-down menu allows movement to a particular category
of features. This is useful in some of the longer lists of features, such as
the flower features where it is then possible, for example, to move
directly to the ‘Calyx’ features or the ‘Corolla’ features.

Finally, the Window menu in the character window allows access to the
Close window menu item. This closes the character window. The
window may also be closed by clicking on the close window symbol in
the title bar of the window (varying with the version of Windows that is
running). However, all data are retained until a new specimen
identification is started. The character window may be re-opened at any
time during an identification, and it will return in the state that it was
left when closed.

Features Used
This menu item under the Characters menu will open up the Features
Used window. This lists all features currently selected from all character
types. It may be opened when required, for checking purposes, or left
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open continuously in one corner of the screen. As features are selected
in any of the character windows, they are automatically added to the
Features Used window.

In addition to showing the features currently selected, the Features Used
window may be used to de-select one or more features. Left-clicking on
a feature in the Features Used window will allow its de-selection. A
message box will open up requesting confirmation of the deletion.
Clicking on ‘Yes’ will delete the feature; clicking on ‘No’ or ‘Cancel’ will
close the message box without deleting the feature.

The Print features used item under the Window menu in the Features
Used window will print the list of features currently selected on an
attached printer. The Close features used window will close the
Features Used window.

Species
The Species menu on the main menu allows access to the List item.
Selecting this will open up the Species window, which lists all remaining
taxa in alphabetical order by family, genus and species. It is possible to
scroll through this list using the vertical scroll bar on the right-hand
side of the window.

The Species window may be opened at any stage when required, to view
the possible identifications, or it may be left open continuously. As
features in the character windows are selected or de-selected, the Species
window is updated to reflect the species remaining.

At any stage, selecting a species in the Species window provides access to
further information on that species. To select a species, move the cursor
to the species name and left-click on the name. The species is
highlighted, and the Show menu in the Species window becomes active.
The drop-down menu under Show provides access to a series of items,
each of which opens up a window with additional information on the
selected species.

The Additional Features window provides information on the species
selected. Information is available on nomenclature, synonymy,
diagnostic features from the leaves, stem, flowers, fruits and seedlings of
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the species, and notes on the distribution, ecology and natural history.
It is possible to control the information displayed in the Additional
Features window. Under the Window menu of the Additional Features
window, each individual component of the information may be selected
or de-selected. These selections remain until the program is closed. Also
available under the Window menu is the ability to show the RFK (rain
forest key) code number. This is the code number assigned to each
species during development of the key. It is mainly of interest to users
of the earlier versions of the key, in that it allows them to track
nomenclatural and taxonomic changes to the species included in those
earlier versions. The font in the Additional Features window may be
changed; see under the Options menu below.

The Leaf Image window displays the x-ray image of a leaf or leaflet for
the selected species. Within the Leaf Image window, a menu allows
display of the image at one of two different sizes. Image size screen
displays the image so that the whole leaf or leaflet fits vertically on the
screen, and is useful in obtaining a general impression of leaf or leaflet
size and shape. Image size 100% displays the image at full scanned
resolution, where the image is generally larger than the screen, and is
useful in examining details of leaf venation. In all cases there is a scale
bar on the image to provide an indication of the actual size of the leaf
or leaflet. The Image information item in the menu of the Leaf Image
window displays information on the voucher specimen and copyright
holder for the currently displayed leaf or leaflet image, and the size of
the scale bar.

The Distribution Map window shows the known distribution within
northern Australia of the currently selected species, based on herbarium
specimens held at the Australian National Herbarium in Canberra
(CANB) and Atherton (QRS), the Northern Territory Herbarium,
Darwin (DNA) and the Queensland Herbarium, Brisbane (BRI).

Photographs are available for many, but not all, species in the rain forest
key. The Photographs item in the Show menu is highlighted if there are
one or more photographs available for the selected taxon. Selecting this
item will display the first of the photographs. If further photographs are
available, as indicated in the title of the Photograph window or in the
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Window menu, they may be accessed in one of two ways. The Window
menu in the Photograph window provides access to all the available
photographs of the selected species. The various items in the menu are
enabled if photographs are available. Additionally, left-clicking in the
Photograph window itself will rotate through all available photographs.
The Photograph information item in the menu of the Photograph
window displays information on the voucher specimen and copyright
holder for the currently displayed photograph, as well as some notes on
the photograph.

Line drawings are available for only a few species. The Line drawing
item in the Show window is highlighted if there is a line drawing
available for the selected taxon. Within the Line Drawing window, a
menu allows display of the drawing at one of two different sizes.
Drawing size screen displays the image so that the whole drawing fits
vertically on the screen, and is useful in obtaining a general impression
of the drawing. Drawing size 100% displays the drawing at full
scanned resolution, where the drawing is generally larger than the
screen, and is useful in examining details on the line drawing. The
Drawing information item in the menu of the Line Drawing window
displays information on the voucher specimen and copyright holder for
the currently displayed drawing, as well as some notes on the drawing.

The Information window available under the Show menu provides
some general information on the family and genus to which the selected
species belongs, together with specific references relating to that family.

Seedling images are available for many, but not all, species in the rain
forest key. The Seedling images item in the Show menu is highlighted if
there are one or more seedling images available for the selected taxon.
There are three different types of seedling image for each taxon, and the
appropriate menu item is enabled if an image is available. The
Cotyledon stage image is a scan of a pressed seedling at the cotyledon
stage. The Tenth leaf stage is a scan of a pressed seedling at the tenth
leaf stage. The Seedling image is a photograph of a seedling. A scale bar
is usually present beside each image. Within the Seedling Image
window, a menu allows display of the image at one of two different
sizes. Image size screen displays the image so that the whole seedling
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fits vertically on the screen, whereas Image size 100% displays the
image at full scanned resolution, where the image is generally larger
than the screen. If more than one image is available, they may be
accessed in one of three ways. The Seedling Images menu under the
Show menu of the Species window gives access to all available images.
In a similar way, so does the Window menu of the Seedling Image
window. Finally, left-clicking in the Seedling Image window itself will
rotate through all available images. The Image information item in the
menu of the Seedling Image window displays information on the
voucher specimen and copyright holder for the currently displayed
image, as well as some notes on the image.

The Features Coded window displays a complete list of the features
coded for the selected species within the key. This may be opened and
compared with the Features Used window when it is desired to
compare a known species with the specimen being identified. Note that
the features coded within this key contain some of the variations within
the species, as well as possible misinterpretations of various features that
a user might make. It is possible to control the information displayed in
the Features Coded window. Under the Window menu of the Features
Coded window, each individual set of characters may be selected or de-
selected. These selections remain until the program is closed. The Print
features coded item under the Window menu will print the full list of
features coded to an attached printer, while the Close features coded
window item will close the Features Coded window.

The Print species item under the Windows menu in the Species
window will print the names of the remaining taxa on an attached
printer. The Close species window item will close the Species window.

Names
Under the Names window there are four different lists of names
available.

Alphabetical by common name
The Alphabetical by common name item opens up a window with a
list of common names, in alphabetical order, together with their
botanical (scientific) name. It is possible to move through the list in a
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number of ways. The vertical scroll bar to the right of the window
allows movement up and down one line at a time, one page at a time,
or to any position by dragging the thumb. It is also possible to move
through the list of names via the Names menu in the Names window. A
drop-down menu allows movement through the list alphabetically. By
left-clicking on any Common Name it is highlighted, and the Show
menu is enabled. This provides access to all the information available on
that taxon in a similar way to the Show menu of the Species window.
Thus, where the information is available, the menu items for Additional
features, Leaf image, Distribution map, Photographs, Line drawing,
Information, Seedling images and Features coded are enabled.

Alphabetical by scientific name
The Alphabetical by scientific name item opens up a window with a
list of common names, in alphabetical order, together with their
common names. The facilities for moving through this list, and the
information available, are the same as those described above for the
Alphabetical by Common Name window. In each of these lists,
Standard Trade Names are given in capital letters, while common names
have lower-case letters.

Genus name with family
The Genus name with family item opens up the Genus List window
with a list of genera, in alphabetical order, together with their family
placement. It is possible to move through the list in a number of ways.
The vertical scroll bar to the right of the window allows movement up
and down one line at a time, one page at a time, or to any position by
dragging the thumb. It is also possible to move through the list of
names via the Genus menu. A drop-down menu allows movement
through the list alphabetically. By left-clicking on any genus name it is
highlighted, and the Show menu is enabled. This provides access to the
information menu, which provides some general information on the
genus, and the family to which it belongs.

Synonyms
The Synonyms item opens up the Synonyms window, which lists all the
scientific names encountered in the key whether they be currently
accepted names, basionyms, nomenclatural or taxonomic synonyms. It is
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possible to move through the list in a number of ways. The vertical scroll
bar to the right of the window allows movement up and down one line
at a time, one page at a time, or to any position by dragging the thumb.
It is also possible to move through the list of names via the Species name
menu. A drop-down menu allows movement through the list
alphabetically. By left-clicking on a name it is highlighted, and the Show
menu is enabled. Under the Show menu there are two menu items. The
List of synonyms item provides the currently accepted name for that
taxon (whether it is the same as or different from the highlighted name),
plus a list of synonyms (where relevant) that have been applied to plants
in Australia. The Publication details item provides information on the
original publication and type specimen of the highlighted name,
whatever its current nomenclatural or taxonomic status.

Options
The Window positions item provides the capability of saving or
recalling preferred window position settings. The save current positions
option will store information on the current size and positions of all
windows in the key, for future use. This can be used to save a favoured
setup of the key, and will become the default setup when re-starting the
key. The restore saved positions option will recall and use the last set of
saved windows positions; this may be useful if the user has temporarily
changed some settings but now wishes to return to the last saved
positions. The restore default positions will recall and use the default
positions as determined by the key, and seen when the key is used for
the first time.

The Font item provides the capability of changing the text font in all
the windows. The windows are divided into three different categories,
and it is possible to set the font separately in each category. The
character windows include those showing the list of characters (habit,
bark, leaf, flower, fruit, seedling and geography) plus the Features Used
and the Features Coded windows. The names windows include the
Species, Common Names, Scientific Names, Genus and Synonyms
windows. The information windows include the Additional Features
and the Information windows. The fonts available in each case are those
present on the computer that fit the required criteria. The fonts
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available for selection in the character and names windows are non-
proportional fonts, while those available in the information windows are
both proportional and non-proportional fonts. The select font option
allows the user to select from the available fonts in each of the
categories of windows. The save selected fonts will save the currently
selected font in each of the windows categories, for future use; this will
become the default font when re-starting the key.

Help
There are several ways in which help may be accessed.

● Select the Help item from the Help menu in the main window for
general help on use of the key, characters and the glossary. See the
note below for more details.

● Help on any window may be obtained under the Help menu in
that window, or by pressing the F1 key when the window has a
highlighted title bar. Help on the various character sets is also
available under the Help menu in the character windows.

● Context-sensitive help is available on the various features by left-
clicking on the feature number, to the left of the red vertical line, in
the various character windows. The help cursor (question mark)
appears when the cursor is in this position.

Note: The Help window in the rain forest key uses the general help system that is
part of Windows. There will therefore be some differences depending on the
version of Windows running. The Help window is re-sizeable, and on initial
opening has two windows, left and right. Various properties may be set in both
the left and right windows by right-clicking within the window (left window
only in some versions of Windows).

The Help window should be minimised when not required, rather then
closed, as then the Windows help system does not have to be re-loaded.
When using the Help window for context-sensitive help on the
characters (by left-clicking on the feature number within the character
window), it is best to close the left window (right-click in the left
window, and choose close; re-size the remaining window). Then simply
call up help on each character in turn. Users can re-open the left
window by choosing Navigate in the menu of the right-hand window.
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The Recall initial help screen menu item provides access to the help
screen that was shown when the program was used for the first time.
This initial help screen provides a brief description of the use of the key.
This screen may be closed temporarily, for the duration of the current
session (by clicking on the ‘Close’ button) or permanently (by clicking
on the ‘Do not show this help screen in future’ button before clicking
on the ‘Close’ button). Either way, the initial help screen may be
recalled at any time by means of the Recall initial help screen menu,
and the settings may then be changed.

The About menu item provides further information on the authors, and
on the many individuals and organisations who have assisted in the
production of this key.
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CHARACTERS

The characters and their various states (features) are listed here, in order
to provide a general overview of the features available for identification
in the key. This list may also be used as a reminder, during normal
operation of the key. Detailed information is available on each feature
in the on-screen help within the key, where the features are defined and,
where appropriate, illustrated.

Habit characters
H 1 Tree
H 2 Shrub
H 3 Vine

Bark characters (trees)
These characters are only available when Tree has been selected under
Habit.

Bark texture
B 1 Bark smooth
B 2 Bark fissured
B 3 Bark tessellated
B 4 Bark papery
B 5 Bark flaky
B 6 Bark nondescript

Bark exudate
B 7 Bark exudate clear
B 8 Bark exudate milky
B 9 Bark exudate yellow
B10 Bark exudate red
B11 Bark exudate absent

Lenticel shape
B12 Lenticels elongated laterally
B13 Lenticels elongated vertically
B14 Lenticels round or irregular in shape
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Lenticel colour or perception
B15 Lenticels black or dark
B16 Lenticels rusty
B17 Lenticels pale
B18 Lenticels inconspicuous

Outer blaze colour
B19 Outer blaze yellow, white or cream
B20 Outer blaze red
B21 Outer blaze pink
B22 Outer blaze brown
B23 Outer blaze mixed colours

Outer blaze markings
B24 Outer blaze speckled markedly
B25 Outer blaze with longitudinal stripes

Outer blaze texture
B26 Outer blaze fibrous
B27 Outer blaze granular

Inner blaze colour
B28 Inner blaze yellow, white or cream
B29 Inner blaze red
B30 Inner blaze pink
B31 Inner blaze brown
B32 Inner blaze mixed colours

Inner blaze markings
B33 Inner blaze speckled markedly
B34 Inner blaze with longitudinal stripes

Inner blaze texture
B35 Inner blaze fibrous
B36 Inner blaze granular
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Blaze layering
B37 Blaze layered

Blaze odour
B38 Blaze odour conspicuous

Blaze thickness
B39 Bark less than 2.5 cm thick
B40 Bark more than 2.5 cm thick

Subrhytidome layer
B41 Subrhytidome layer brown or black
B42 Subrhytidome layer yellow, white or cream
B43 Subrhytidome layer pink-red
B44 Subrhytidome layer green

Trunk fluting
B45 Trunk markedly fluted

Coppice shoots
B46 Coppice at the base of the stem

Buttresses
B47 Buttresses absent
B48 Buttresses present

Bark characters (vines)
These characters are only available when Vine has been selected under
Habit. They should only be used for the larger vines that have a distinct
bark; they are not applicable to slender, basically herbaceous vines.

Climbing method
VB 1 Twiner
VB 2 Tendril
VB 3 Hook
VB 4 Root
VB 5 Branch
VB 6 Leaner
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Stem (in cross-section)
VB  7 Normal
VB  8 Fluted

Bark texture
VB 9 Bark smooth
VB10 Bark fissured
VB11 Bark tessellated
VB12 Bark papery
VB13 Bark flaky
VB14 Bark corky
VB15 Bark thorny
VB16 Bark nondescript

Lenticel shape
VB17 Lenticels elongated laterally
VB18 Lenticels elongated vertically
VB19 Lenticels round or irregular in shape

Lenticel colour or perception
VB20 Lenticels black or dark
VB21 Lenticels rusty
VB22 Lenticels pale
VB23 Lenticels inconspicuous

Phloem presence or absence
VB24 Phloem, i.e. living bark, present
VB25 Phloem absent

Subrhytidome layer
VB26 Subrhytidome layer brown or black
VB27 Subrhytidome layer cream
VB28 Subrhytidome layer pink-red
VB29 Subrhytidome layer green

Bark exudate
VB30 Bark exudate clear
VB31 Bark exudate milky
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VB32 Bark exudate yellow
VB33 Bark exudate red
VB34 Bark exudate absent

Blaze colour
VB35 Blaze yellow, white or cream 
VB36 Blaze red
VB37 Blaze pink
VB38 Blaze brown
VB39 Blaze speckled markedly
VB40 Blaze with longitudinal stripes

Blaze texture
VB41 Blaze fibrous
VB42 Blaze granular

Blaze layering
VB43 Blaze layered

Blaze odour
VB44 Blaze odour conspicuous

Wood characters
VB45 Vascular rays obvious
VB46 Vessels in radial lines
VB47 Vessels in tangential lines
VB48 Sections of bark in the wood

Leaf characters
Leaf presence/absence

L 1 Leaves present
L 2 Leaves never present or not photosynthetically active

Leaf type
L 3 Leaves simple
L 4 Leaves compound
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Leaf arrangement (of simple or compound leaves)
L 5 Leaves alternately or spirally arranged
L 6 Leaves opposite
L 7 Leaves whorled
L 8 Leaves basal or radical

Stipules
L 9 Stipules or stipular scars present
L10 Stipules or stipular scars absent

Oil dots (in leaves, or leaflets in compound leaves)
L11 Oil dots visible to the naked eye
L12 Oil dots visible with a lens
L13 Oil dots absent

Leaf or leaflet length/breadth ratio (leaflet in compound leaves)
L14 Leaf length/breadth ratio less than 1.5
L15 Leaf length/breadth ratio 1.5–4
L16 Leaf length/breadth ratio more than 4

Leaf or leaflet margin (leaflet in compound leaves)
L17 Leaf margin smooth
L18 Leaf margin toothed
L19 Leaf margin lobed

Leaf or leaflet intramarginal vein (leaflet in compound leaves)
L20 Intramarginal vein present
L21 Intramarginal vein absent

Leaf or leaflet venation (leaflet in compound leaves)
L22 Leaf three-veined
L23 No lateral veins either side of the midrib
L24 Up to 7 lateral veins on each side of the midrib
L25 8–20 lateral veins on each side of the midrib
L26 More than 20 veins on each side of the midrib
L27 Leaves with longitudinally parallel venation
L28 Other types of venation
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Leaf or leaflet midrib (leaflet in compound leaves)
L29 Midrib distinctly raised on the upper surface
L30 Midrib distinctly depressed on the upper surface
L31 Midrib more or less flush with the upper surface

Leaf or leaflet lateral vein angle (leaflet in compound leaves)
L32 Lateral vein angle less than 30 degrees
L33 Lateral vein angle 30–60 degrees
L34 Lateral vein angle more than 60 degrees

Domatia (in leaf, or leaflet in compound leaves)
L35 Undersurface with domatia

Leaf or leaflet undersurface texture (leaflet in compound leaves)
L36 Undersurface smooth
L37 Undersurface hairy or sandpapery

Leaf or leaflet undersurface colour (leaflet in compound leaves)
L38 Undersurface same colour as the upper surface
L39 Undersurface paler green than the upper surface
L40 Undersurface rusty-brown to white but not from hairs

Petiole or leaflet stalk length (leaflet stalk in compound leaves)
L41 Petiole absent (leaves or leaflets sessile)
L42 Petiole short (less than 1/5 of the leaf blade)
L43 Petiole long (more than 1/5 of the blade)

Petiole or leaflet stalk margin (leaflet stalk in compound leaves)
L44 Petiole distinctly winged
L45 Petiole not winged

Pulvinus
L46 Pulvinus present
L47 Pulvinus absent
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Leaf division in compound leaves
L48 Compound leaves with three leaflets
L49 Compound leaves digitate
L50 Compound leaves pinnate (with as few as two leaflets)
L51 Compound leaves bipinnate or tripinnate

Terminal leaflet in compound leaves (pinnate, bipinnate or
tripinnate)

L52 Terminal leaflet present
L53 Terminal leaflet absent 

Leaflet arrangement in compound leaves (pinnate, bipinnate or
tripinnate)

L54 Leaflets opposite
L55 Leaflets alternate

Leaflet number in compound leaves (pinnate, bipinnate, tripinnate
or digitate)

L56 Up to 7 leaflets in the compound leaf
L57 8–20 leaflets in the compound leaf
L58 More than 20 leaflets in the compound leaf

Leaf rhachis in compound leaves (pinnate, bipinnate or tripinnate)
L59 Rhachis distinctly winged
L60 Rhachis not winged

Leaf or leaflet shape (leaflet in compound leaves)
L61 Leaves or leaflets linear
L62 Leaves or leaflets oblong
L63 Leaves or leaflets lanceolate
L64 Leaves or leaflets elliptic
L65 Leaves or leaflets falcate
L66 Leaves or leaflets rhomboid
L67 Leaves or leaflets ovate
L68 Leaves or leaflets orbicular
L69 Leaves or leaflets obovate
L70 Leaves or leaflets triangular, cordate or palmate
L71 Leaves or leaflets cuneate
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Leaf or leaflet apex (leaflet in compound leaves)
L72 Apex subulate
L73 Apex aristate
L74 Apex acuminate
L75 Apex mucronate
L76 Apex apiculate
L77 Apex acute
L78 Apex obtuse
L79 Apex retuse
L80 Apex emarginate
L81 Apex truncate

Leaf or leaflet base (leaflet in compound leaves)
L82 Base cuneate
L83 Base attenuate
L84 Base obtuse
L85 Base cordate
L86 Base auriculate
L87 Base sagittate
L88 Base hastate
L89 Base truncate
L90 Base oblique
L91 Base peltate
L92 Base perfoliate
L93 Base sheathing

Leaf or leaflet margin (leaflet in compound leaves)
L94 Margin entire
L95 Margin serrate
L96 Margin dentate
L97 Margin crenate
L98 Margin sinuate
L99 Margin undulate
L100 Margin lobed
L101 Margin pinnatifid
L102 Margin pinnatisect
L103 Margin palmatifid
L104 Margin palmatisect
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Leaf attachment (of simple or compound leaves)
L105 Leaf base or petiole sheathing stem or leafy axis
L106 Leaf base or petiole not sheathing stem or leafy axis

Appendages or modifications which may or may not be involved
in climbing

L107 Stems and/or branches twining
L108 Tendrils present
L109 Hooks or spines present
L110 Branches obviously modified
L111 Adventitious roots or haustoria present

Flower characters
Inflorescence position

FL 1 Inflorescence terminal
FL 2 Inflorescence axillary or basal
FL 3 Inflorescence cauliflorous
FL 4 Inflorescence ramiflorous

Inflorescence type
FL 5 Inflorescence a solitary flower
FL 6 Inflorescence a raceme
FL 7 Inflorescence a spike
FL 8 Inflorescence a corymb
FL 9 Inflorescence an umbel
FL10 Inflorescence a fascicle
FL11 Inflorescence a cyme
FL12 Inflorescence a panicle
FL13 Inflorescence a head
FL14 Inflorescence a cone

Flower sexuality
FL15 Flowers unisexual
FL16 Flowers bisexual
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Plant sexuality (when flowers unisexual)
FL17 Plant monoecious
FL18 Plant dioecious

Flower size (when fully developed)
FL19 Flowers small (less than 10 mm diam)
FL20 Flowers large (more than 10 mm diam)

Flower perianth form
FL21 Flowers with distinct sepals and petals
FL22 Flowers with 2 (or more) similar perianth whorls
FL23 Flowers with 1 perianth whorl
FL24 Flowers with no perianth

Number of floral parts
FL25 Flowers 2-merous
FL26 Flowers 3-merous
FL27 Flowers 4-merous
FL28 Flowers 4-merous
FL29 Flowers 6-merous
FL30 Flowers more than 6-merous, or not distinguishable

Flower symmetry
FL31 Flowers actinomorphic (regular)
FL32 Flowers slightly zygomorphic (bilateral)
FL33 Flowers markedly zygomorphic (bilateral)

Flower form
FL34 Flowers hypogynous
FL35 Flowers perigynous
FL36 Flowers epigynous

Where calyx and corolla are not clearly differentiated, go to
corolla features

Calyx fusion
FL37 Calyx of fused sepals
FL38 Calyx of free sepals
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Extent of calyx fusion
FL39 Sepals fused for more than half their length
FL40 Sepals fused for less than half their length

Calyx parts
FL41 Calyx none
FL42 Calyx of 1 sepal or lobe
FL43 Calyx of 2 sepals or lobes
FL44 Calyx of 3 sepals or lobes
FL45 Calyx of 4 sepals or lobes
FL46 Calyx of 5 sepals or lobes
FL47 Calyx of 5 or more sepals or lobes
FL48 Calyx calyptrate, sepals fused to form an operculum

Calyx colour at anthesis
FL49 Calyx white, cream, translucent or transparent
FL50 Calyx brown
FL51 Calyx green
FL52 Calyx yellow
FL53 Calyx orange
FL54 Calyx pink
FL55 Calyx red
FL56 Calyx blue
FL57 Calyx purple or black

Corolla fusion
FL58 Corolla of free petals
FL59 Corolla of fused petals

Extent of corolla fusion
FL60 Petals fused for more than half their length
FL61 Petals fused for less than half their length
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Corolla parts
FL62 Corolla none
FL63 Corolla of 1 petal
FL64 Corolla of 2 petals
FL65 Corolla of 3 petals
FL66 Corolla of 4 petals
FL67 Corolla of 5 petals
FL68 Corolla of 6 or more petals
FL69 Corolla calyptrate, petals fused to form an operculum

Corolla colour at anthesis
FL70 Corolla white, cream, translucent or transparent
FL71 Corolla brown
FL72 Corolla green
FL73 Corolla yellow
FL74 Corolla orange
FL75 Corolla pink
FL76 Corolla red
FL77 Corolla blue
FL78 Corolla purple or black

Petal aestivation
FL79 Petals not touching in bud
FL80 Petals valvate in bud
FL81 Petals imbricate (including contorted) in bud

Stamen number
FL82 Stamens none
FL83 Stamens 1
FL84 Stamens 2
FL85 Stamens 3
FL86 Stamens 4
FL87 Stamens 5
FL88 Stamens 6–10
FL89 Stamens 11–25
FL90 Stamens more than 25
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Stamen number in relation to the petals or corolla lobes (sepals or
tepals if corolla absent)

FL91 Stamens fewer than petals
FL92 Stamens same number as petals
FL93 Stamens twice the number of petals
FL94 Stamens more than twice the number of petals
FL95 Stamen number not related to petal number

Stamen position in relation to the petals or corolla lobes
FL96 Stamens alternating with the petals
FL97 Stamens opposite the petals
FL98 Stamens not related to petal position

Stamen position in relation to the sepals (or tepals) (where corolla
absent)

FL99 Stamens alternating with the sepals (or tepals)
FL100 Stamens opposite the sepals (or tepals)
FL101 Stamens not related to sepal (or tepal) position

Stamen fusion
FL102 Stamens free from one another
FL103 Stamens fused to one another

Stamen fusion to other floral parts
FL104 Stamens epipetalous
FL105 Stamens episepalous (or epitepalous)

Staminodes
FL106 Staminodes present
FL107 Staminodes absent

Anther shape
FL108 Anthers wider than long (including reniform)
FL109 Anthers globose or equidimensional or nearly so
FL110 Anthers longer than wide
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Anther dehiscence
FL111 Anthers opening by apical pores
FL112 Anthers opening by lateral pores
FL113 Anthers opening by apical slits
FL114 Anthers opening by longitudinal slits
FL115 Anthers opening by transverse slits
FL116 Anthers opening by valves

Anther attachment position
FL117 Anthers basifixed
FL118 Anthers dorsifixed or ventrifixed

Anther attachment type
FL119 Anthers versatile
FL120 Anthers not versatile

Anther locule number
FL121 Anther locules 1
FL122 Anther locules 2
FL123 Anther locules 3
FL124 Anther locules 4
FL125 Anther locules more than 4

Anther opening
FL126 Anthers introrse
FL127 Anthers extrorse
FL128 Anthers opening laterally

Filament length
FL129 Filament very short/absent (< 0.25 length of anther)
FL130 Filament short (0.25–2.0 times length of anther)
FL131 Filament long (more than 2.0 times length of anther)

Male flower rudimentary ovary
FL132 Male flowers with a rudimentary ovary present
FL133 Male flowers with no rudimentary ovary
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Gynoecium fusion (to be used with caution)
FL134 Gynoecium of a single carpel (unicarpellate)
FL135 Gynoecium apocarpous (of 2 or more free carpels)
FL136 Gynoecium syncarpous (of 2 or more fused carpels)

Gynoecium position
FL137 Gynoecium (ovary) inferior
FL138 Gynoecium (ovary) half-inferior
FL139 Gynoecium (ovary) superior

Carpel number (when apocarpous)
FL140 Gynoecium of 2 free carpels
FL141 Gynoecium of 3 free carpels
FL142 Gynoecium of 4 free carpels
FL143 Gynoecium of 5 free carpels
FL144 Gynoecium of 6 or more free carpels

Locule number (when syncarpous or unicarpellate)
FL145 Fused gynoecium with 1 locule
FL146 Fused gynoecium with 2 locules
FL147 Fused gynoecium with 3 locules
FL148 Fused gynoecium with 4 locules
FL149 Fused gynoecium with 5 locules
FL150 Fused gynoecium with 6 or more locules

Placentation
FL151 Placentation marginal
FL152 Placentation axile
FL153 Placentation parietal
FL154 Placentation free central (including free basal)
FL155 Placentation apical
FL156 Placentation basal

Style form and number (number per flower, not per carpel)
FL157 Style absent (stigma sessile)
FL158 Style single, unbranched
FL159 Style single, branched (2 or more fused)
FL160 Style more than 1 (2 or more free)
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Stigma number (number per flower, not per style)
FL161 Stigmas 1
FL162 Stigmas 2
FL163 Stigmas 3
FL164 Stigmas 4
FL165 Stigmas 5
FL166 Stigmas 6 or more

Fruit characters
Fruit

FR 1 Fruit fleshy
FR 2 Fruit dry, leathery or woody

Fruit derivation (to be used with caution)
FR 3 Fruit simple
FR 4 Fruit aggregate
FR 5 Fruit multiple

Fruit type
FR 6 Fruit a follicle
FR 7 Fruit a capsule
FR 8 Fruit a samara
FR 9 Fruit a nut
FR10 Fruit a plumed achene
FR11 Fruit a cone

Fruit dehiscence
FR12 Fruit dehiscent
FR13 Fruit indehiscent
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Fruit colour
FR14 Fruit white or cream
FR15 Fruit brown
FR16 Fruit green
FR17 Fruit yellow
FR18 Fruit orange
FR19 Fruit pink
FR20 Fruit red
FR21 Fruit blue
FR22 Fruit purple
FR23 Fruit black

Seeds per fruit
FR24 Seeds 1 per fruit
FR25 Seeds 2 per fruit
FR26 Seeds more than 2 per fruit

Seed size (not including aril, if present)
FR27 Seed small (10 mm long or less, including appendages)
FR28 Seed large (10 mm long or more, including appendages)

Testa colour
FR29 Testa white or cream
FR30 Testa brown
FR31 Testa green
FR32 Testa yellow
FR33 Testa orange
FR34 Testa pink
FR35 Testa red
FR36 Testa blue
FR37 Testa purple
FR38 Testa black

Aril presence or absence
FR39 Seed with a distinct aril
FR40 Seed without a distinct aril
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Aril colour
FR41 Aril white, cream, translucent or transparent
FR42 Aril brown
FR43 Aril green
FR44 Aril yellow
FR45 Aril orange
FR46 Aril pink
FR47 Aril red
FR48 Aril blue
FR49 Aril purple
FR50 Aril black

Seed wing
FR51 Seed with a distinct membranous wing or wings
FR52 Seed with distinct hairs or plumes
FR53 Seed not distinctly winged or plumed

Endosperm presence or absence
FR54 Endosperm present
FR55 Endosperm absent

Endosperm texture
FR56 Endosperm ruminate
FR57 Endosperm not ruminate

Cotyledon form (within the seed)
FR58 Cotyledons folded or rolled
FR59 Cotyledons straight or slightly curved

Cotyledon texture (within the seed)
FR60 Cotyledons ruminate
FR61 Cotyledons not ruminate

Radicle form (within the seed)
FR62 Radicle straight
FR63 Radicle curved
FR64 Radicle coiled, recurved or U-shaped
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Seedling characters
It is advisable to use Seedling characters alone or in combination with
geographic distribution only. There is no certainty that the seedling growing
nearby or under an adult plant is the same species as that plant; the seed
may not have come from that species.

Germination type
S 1 Germination epigeal
S 2 Germination semi-hypogeal
S 3 Germination hypogeal
S 4 Germination ‘durian’

Cotyledons (in seeds with epigeal germination only)

Cotyledon size
S 5 Cotyledons less than 5 mm
S 6 Cotyledons 5–20 mm
S 7 Cotyledons 20–60 mm
S 8 Cotyledons more than 60 mm

Cotyledon shape
S 9 Cotyledons wider than long
S10 Cotyledons longer than wide

Cotyledon petiole
S11 Cotyledons petiolate
S12 Cotyledons sessile

Cotyledon apex
S13 Cotyledon apex acute
S14 Cotyledon apex obtuse
S15 Cotyledon apex retuse or emarginate

Cotyledon base
S16 Cotyledon base cuneate to attenuate
S17 Cotyledon base rounded
S18 Cotyledon base cordate to sagittate
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Cotyledon venation
S19 Cotyledons with midrib alone or no veins visible
S20 Cotyledons penniveined
S21 Cotyledons 3-veined
S22 Cotyledons with other types of venation

Cotyledon oil dots
S23 Cotyledons with oil dots visible with a x10 lens
S24 Cotyledons with no oil dots visible with a x10 lens

Cotyledon lower surface
S25 Cotyledon lower surface hairy
S26 Cotyledon lower surface glabrous

Cotyledon margin
S27 Cotyledon margin smooth
S28 Cotyledon margin toothed or lobed

Cataphylls
S29 Cataphylls present
S30 Cataphylls absent

Leaf type (first pair of fully developed, normal leaves)
S31 First pair of true leaves simple
S32 First pair of true leaves compound, not with 3 leaflets
S33 First pair of true leaves compound, with 3 leaflets

Leaf arrangement (first pair of fully developed, normal leaves)
S34 First pair of true leaves alternate
S35 First pair of true leaves opposite or part of a whorl

Tenth leaf stage (stage at which tenth leaf is produced)

Oil dots
S36 Tenth leaf with oil dots visible with a x10 lens
S37 Tenth leaf with no oil dots visible with a x10 lens
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Stipules
S38 Tenth leaf with stipules present
S39 Tenth leaf with stipules absent

Leaf arrangement
S40 Tenth leaf alternate
S41 Tenth leaf opposite
S42 Tenth leaf forming part of a whorl

Leaf type
S43 Tenth leaf simple
S44 Tenth leaf compound with three leaflets
S45 Tenth leaf compound not consisting of three leaflets

Leaf division
S46 Tenth leaf bipinnate

Terminal leaflet (pinnate compound leaves)
S47 Tenth leaf with a terminal leaflet present
S48 Tenth leaf with a terminal leaflet absent

Leaflet arrangement (pinnate compound leaves)
S49 Tenth leaf with opposite leaflets
S50 Tenth leaf with alternate leaflets

Digitate or palmate compound leaf (not pinnate leaves)
S51 Tenth leaf with 4 or more leaflets from the centre

Leaflet number in the compound leaf (pinnate and palmate leaves)
S52 Tenth leaf with up to 7 leaflets
S53 Tenth leaf with 8–20 leaflets
S54 Tenth leaf with more than 20 leaflets

Leaf margin (leaflet margin in compound leaves)
S55 Tenth leaf with smooth margin
S56 Tenth leaf with toothed margin
S57 Tenth leaf with lobed margin

Characters
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Intramarginal vein (in leaflet in compound leaves)
S58 Tenth leaf with an intramarginal vein
S59 Tenth leaf without an intramarginal vein

Leaf venation (leaflet in compound leaves)
S60 Tenth leaf with midrib but no other veins visible
S61 Tenth leaf penniveined
S62 Tenth leaf 3-veined
S63 Tenth leaf with other types of venation

Lateral vein angle (in leaflet in compound leaves)
S64 Tenth leaf with vein angle less than 30 degrees
S65 Tenth leaf with vein angle 30–60 degrees
S66 Tenth leaf with vein angle more than 60 degrees

Leaf blade undersurface texture (leaflet in compound leaves)
S67 Tenth leaf undersurface smooth
S68 Tenth leaf undersurface hairy

Leaf blade undersurface colour (leaflet in compound leaves)
S69 Tenth leaf undersurface green
S70 Tenth leaf undersurface brown to white

Petiole (leaflet stalk in compound leaves)
S71 Tenth leaf petiole short (less than 1/5 of leaf blade)
S72 Tenth leaf petiole long (more than 1/5 of leaf blade)

Pulvini (leaflet in compound leaves)
S73 Tenth leaf pulvinus present
S74 Tenth leaf pulvinus absent

Petiole exudate
S75 Tenth leaf petiole exudate clear
S76 Tenth leaf petiole exudate milky
S77 Tenth leaf petiole exudate yellow
S78 Tenth leaf petiole exudate red
S79 Tenth leaf petiole exudate absent
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Terminal bud
S80 Tenth leaf stage – terminal bud smooth
S81 Tenth leaf stage – terminal bud hairy

Seedling stem cross-section
S82 Tenth leaf stage – stem terete, i.e. circular
S83 Tenth leaf stage – stem 4-angled, i.e. square
S84 Tenth leaf stage – stem winged

Seedling stem texture
S85 Tenth leaf stage – stem smooth
S86 Tenth leaf stage – stem hairy

Characters
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Acanthaceae          
Actinidiaceae         
Agavaceae           
Alangiaceae          
Alseuosmiaceae        
Amaranthaceae         
Anacardiaceae         
Annonaceae          
Apiaceae           
Apocynaceae          
Aquifoliaceae         
Araceae            
Araliaceae          
Araucariaceae         
Arecaceae           
Aristolochiaceae       
Asclepiadaceae        
Asteraceae          
Austrobaileyaceae       
Balanopaceae         
Balsaminiaceae        
Basellaceae          
Bignoniaceae         
Bixaceae           
Bombacaceae          
Boraginaceae         
Burseraceae          
Caesalpiniaceae        
Campanulaceae         
Cannaceae           
Capparaceae          
Caprifoliaceae        
Cardiopteridaceae       
Casuarinaceae         

Celastraceae         
Chenopodiaceae        
Chrysobalanaceae       
Clusiaceae          
Combretaceae         
Commelinaceae         
Connaraceae          
Convolvulaceae        
Corynocarpaceae        
Costaceae           
Crassulaceae         
Cucurbitaceae         
Cunoniaceae          
Cupressaceae         
Cycadaceae          
Cyperaceae          
Datiscaceae          
Davidsoniaceae        
Dichapetalaceae        
Dilleniaceae         
Dioscoreaceae         
Ebenaceae           
Elaeagnaceae         
Elaeocarpaceae        
Epacridaceae         
Ericaceae           
Erythroxylaceae        
Eucryphiaceae         
Euphorbiaceae         
Eupomatiaceae         
Fabaceae           
Flacourtiaceae        
Flagellariaceae        
Gesneriaceae         

Goodeniaceae         
Grossulariaceae        
Gyrostemonaceae        
Hamamelidaceae        
Hanguanaceae         
Hernandiaceae         
Himantandraceae        
Hippocrateaceae        
Icacinaceae          
Idiospermaceae        
Juncaceae           
Lamiaceae           
Lauraceae           
Lecythidaceae         
Leeaceae           
Liliaceae           
Linaceae           
Loganiaceae          
Lythraceae          
Malpighiaceae         
Malvaceae           
Melastomataceae        
Meliaceae           
Menispermaceae        
Mimosaceae          
Monimiaceae          
Moraceae           
Moringaceae          
Musaceae           
Myoporaceae          
Myristicaceae         
Myrsinaceae          
Myrtaceae           
Nepenthaceae         
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Nyctaginaceae         
Ochnaceae           
Olacaceae           
Oleaceae           
Onagraceae          
Opiliaceae          
Orchidaceae          
Pandanaceae          
Passifloraceae        
Pedaliaceae          
Philydraceae         
Phytolaccaceae        
Piperaceae          
Pittosporaceae        
Plumbaginaceae        
Poaceae            
Podocarpaceae         
Polygonaceae         

Proteaceae          
Ranunculaceae         
Rhamnaceae          
Rhizophoraceae        
Rosaceae           
Rubiaceae           
Rutaceae           
Santalaceae          
Sapindaceae          
Sapotaceae          
Scrophulariaceae       
Simaroubaceae         
Smilacaceae          
Solanaceae          
Stangeriaceae         
Stemonaceae          
Sterculiaceae         
Surianaceae          

Symplocaceae         
Taccaceae           
Theaceae           
Thymelaeaceae         
Tiliaceae           
Ulmaceae           
Urticaceae          
Verbenaceae          
Violaceae           
Viscaceae           
Vitaceae           
Winteraceae          
Xanthophyllaceae       
Xanthorrhoeaceae       
Zamiaceae           
Zingiberaceae         

Characters

Geographic characters
G1 Western Australia (WA)
G2 Northern Territory (NT)
G3 Cape York Peninsula (CYP)
G4 North-east Queensland (NEQ)
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